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R&S®NRP Series Safety Information

1 Safety Information

The product documentation helps you use the R&S NRP series power sensor
safely and efficiently. Follow the instructions provided here and in the printed
"Basic Safety Instructions". Keep the product documentation nearby and offer it to
other users.

Intended use

The R&S NRP series power sensor is intended for the development, production
and verification of electronic components and devices in industrial, administrative,
and laboratory environments. Use the R&S NRP series power sensor only for its
designated purpose. Observe the operating conditions and performance limits
stated in the data sheet.

Where do | find safety information?

Safety information is part of the product documentation. It warns you about the
potential dangers and gives instructions how to prevent personal injuries or dam-
age caused by dangerous situations. Safety information is provided as follows:

® The printed "Basic Safety Instructions" provide safety information in many lan-
guages and are delivered with the R&S NRP series power sensor.

® Throughout the documentation, safety instructions are provided when you
need to take care during setup or operation.
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Tutorials
2 Documentation Overview

This section provides an overview of the R&S NRP series power sensor user doc-
umentation. Unless specified otherwise, you find the documents on the R&S NRP
series power sensor product page at:

www.rohde-schwarz.com/product/nrp-a-an
www.rohde-schwarz.com/product/nrp_s_sn
www.rohde-schwarz.com/product/nrp18s-xx
www.rohde-schwarz.com/product/nrp-t-tn

www.rohde-schwarz.com/product/nrp-twg

2.1 Getting Started Manual

Introduces the R&S NRP series power sensor and describes how to set up and
start working with the product. Includes basic operations and general information,
e.g. safety instructions, etc. A printed version is delivered with the power sensor.

2.2 User Manuals

Contains the description of all instrument modes and functions. It also provides
an introduction to remote control, a complete description of the remote control
commands with programming examples, and information on maintenance and
interfaces. Includes the contents of the getting started manual.

2.3 Tutorials

Tutorials offer guided examples and demonstrations on operating the R&S NRP
series power sensor. They are provided on the product page of the internet.
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R&S®NRP Series Documentation Overview

Release Notes and Open Source Acknowledgment (OSA)

2.4 Instrument Security Procedures

Deals with security issues when working with the R&S NRP series power sensor
in secure areas. It is available for download on the Internet.

2.5 Basic Safety Instructions

Contains safety instructions, operating conditions and further important informa-
tion. The printed document is delivered with the instrument.

2.6 Data Sheets and Brochures

The data sheet contains the technical specifications of the R&S NRP series
power sensor. It also lists the firmware applications and their order numbers, and
optional accessories.

The brochure provides an overview of the instrument and deals with the specific
characteristics.

www.rohde-schwarz.com/brochure-datasheet/nrp-a-an
www.rohde-schwarz.com/brochure-datasheet/nrp_s sn
www.rohde-schwarz.com/brochure-datasheet/nrp18s-xx
www.rohde-schwarz.com/brochure-datasheet/nrp-t-tn

www.rohde-schwarz.com/brochure-datasheet/nrp-twg

2.7 Release Notes and Open Source Acknowledg-
ment (OSA)

The release notes list new features, improvements and known issues of the cur-
rent firmware version, and describe the firmware installation.
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Application Notes, Application Cards, White Papers, etc.

The "Open Source Acknowledgment" is provided on the user documentation CD-
ROM, included in the delivery. It contains verbatim license texts of the used open
source software.

www.rohde-schwarz.com/firmware/nrp-a-an
www.rohde-schwarz.com/firmware/nrp_s_sn
www.rohde-schwarz.com/firmware/nrp18s-xx
www.rohde-schwarz.com/firmware/nrp-t-tn

www.rohde-schwarz.com/firmware/nrp-twg

2.8 Application Notes, Application Cards, White
Papers, etc.

These documents deal with special applications or background information on
particular topics.

www.rohde-schwarz.com/application/nrp_s_sn

www.rohde-schwarz.com/application/nrp18s-xx
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3  Key Features

The R&S NRP series power sensors are the successors of the established
R&S NRP-Z series of RF power sensors.

They provide a high-speed USB interface that constitutes both the communication
port and the power supply connection.

Also, most sensors are available with an additional Gigabit Ethernet interface with
Power-over-Ethernet (PoE) power supply. The power sensors with networking
capabilities, the R&S NRP LAN power sensors, are marked with a trailing N in
their names:

® R&S NRPxxSN
® R&S NRPxxAN
® R&S NRPxxTN
The R&S NRP series power sensors are compatible with the R&S NRP-Z power

sensors in both the interface (USB) and a common command subset. This com-
patibility makes the replacement of the old power sensors easy.

For a detailed specification, refer to the data sheet.
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Operating Conditions
4 Preparing for Use

For information on safety, see:
® Chapter 1, "Safety Information", on page 5
® Chapter 4.2, "Operating Conditions", on page 10

4.1 Unpacking and Checking the Power Sensor

Check the equipment for completeness using the delivery note and the accessory
lists for the various items. Check the power sensor for any damage. If there is
damage, immediately contact the carrier who delivered the power sensor. Make
sure not to discard the box and packing material.

Packing material

Retain the original packing material. If the instrument needs to be transpor-
ted or shipped later, you can use the material to protect the control elements
and connectors.

4.2 Operating Conditions

A CAUTION

Risk of injury through hot surfaces
Applies only to the R&S NRP18S-xx power sensors.

Under certain conditions, the maximum surface temperatures of the power
sensor can exceed the limits defined in EN 61010-1.

Provide protection against unintentional contact and wear appropriate per-
sonal protective equipment when touching the sensor.

Specific operating conditions are required to ensure accurate measurements and
to avoid damage to the power sensor and connected devices. Before switching
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Considerations for Test Setup

on the power sensor, observe the information on appropriate operating conditions
provided in the basic safety instructions and the data sheet of the power sensor.
In particular, ensure the following:

® The power sensor is dry and shows no sign of condensation.

® The ambient temperature does not exceed the range specified in the data
sheet.

® Signal levels at the input connectors are all within the specified ranges.
® Signal outputs are connected correctly and are not overloaded.

4.3 Considerations for Test Setup

NOTICE

Handling the R&S NRP33SN-V power sensor
Risk of contamination

Always wear clean protective gloves when handling the R&S NRP33SN-V
vacuum power sensors to protect the device and its environment from con-
tamination.

Recommended bake-out procedure

When the sensor is inserted in a vacuum chamber, perform vacuum baking
for 100 hours at 85°C at a pressure lower than 10-° mbar.

Preventing electrostatic discharge (ESD)

ESD is most likely to occur when you connect or disconnect a DUT.

» NOTICE! Risk of electrostatic discharge (ESD). Electrostatic discharge (ESD)
can damage the electronic components of the power sensor and the device
under test (DUT).

Ground yourself to avoid electrostatic discharge (ESD) damage:

e Using a wrist strap and cord, connect yourself to the ground.
e Use a conductive floor mat and heel strap combination.
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Connecting to a DUT
EMI impact on measurement results
Electromagnetic interference (EMI) may affect the measurement results.

To suppress generated electromagnetic interference (EMI):

® Use suitable shielded cables of high quality. For example, use double-shielded
RF and LAN cables.

® Always terminate open cable ends.
® Note the EMC classification in the data sheet.

44 Connecting to a DUT

For connecting the power sensor to a DUT, use the RF connector. See Chap-
ter 5.1, "RF Connector", on page 26.

NOTICE

Risk of overloading the sensor

Using a power sensor at a level above its upper measuring limit can dam-
age the sensor head. To avoid this risk, make sure not to exceed the test
limit.

The test limits specified on the type label are valid only for the supplied
attenuator. For operation without attenuator, lower test limits apply, as
specified in the data sheet.

To connect to the DUT

1. Ensure that the RF connector of your DUT is compatible with the RF connec-
tor of the power sensor.

2. Insert the RF connector straight into the RF output of your DUT. Take care not
to tilt it.

G [} -

| =, =1

3. NOTICE! Risk of damaging the center pin of the RF connector. Always rotate
only the hex nut of the RF connector. Never rotate the power sensor itself.
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Connecting a Cable to the Host Interface

Tighten the RF connector manually.

4. To ensure maximum measurement accuracy, tighten the RF connector using a
torque wrench with the nominal torque recommended in Chapter 5.1, "RF
Connector", on page 26.

To disconnect from the DUT
» NOTICE! Risk of damaging the center pin of the RF connector. Always rotate
only the hex nut of the RF connector. Never rotate the power sensor itself.

Carefully loosen the union nut at the front of the RF connector of the sensor
and remove the sensor.

4.5 Connecting a Cable to the Host Interface

For connecting the power sensor to a USB host, use the host interface. See
Chapter 5.3, "Host Interface", on page 28.

Depending on the USB host, use one of the following cables:

® Computer or R&S NRP-Z5 sensor hub:
R&S NRP-ZKU cable with a USB connector, R&S order number 1419.0658.xx
See Chapter 4.6.1, "Computer”, on page 14.

® Base units, R&S NRX or R&S NRP2, or other supported Rohde & Schwarz
instruments:
R&S NRP-ZK6 cable with a push-pull type connector, R&S order number
1419.0664 .xx
See Chapter 4.6.2, "Base Unit", on page 17.

These cables can be obtained in different lengths up to 5 meters.

To connect a cable to the host interface of the power sensor

1. Insert the screw-lock cable connector into the host interface connector of the
power Sensor.

2. Tighten the union nut manually.

To disconnect the host interface of the power sensor

» Loosen the union nut of the screw-lock cable connector and remove the cable.
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Connecting to a Controlling Host

4.6 Connecting to a Controlling Host

As a controlling host, you can use:
® Computer
® Base Unit

For operating the power sensor, you can choose from various possibilities. For
details, see Chapter 6, "Operating Concepts", on page 31.

4.6.1 Computer

If the controlling host is a computer, you can operate the power sensor using a
supported software, the web user interface or remote control. For details, see
Chapter 6, "Operating Concepts", on page 31.

» Establish the connection using:

e Host interface

See Chapter 4.6.1.1, "Simple USB Connection", on page 14.

See Chapter 4.6.1.2, "R&S NRP-Z5 Sensor Hub Setup", on page 15.
e LAN interface, if the power sensor is a LAN power sensor

See Chapter 4.6.3, "Using a LAN Connection", on page 18.

4.6.1.1 Simple USB Connection

All R&S NRP power sensors can be connected to the USB interface of a com-
puter.
Required equipment

® R&S NRP power sensor
® R&S NRP-ZKU cable
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Connecting to a Controlling Host

Setup

(6
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Figure 4-1: Setup with an R&S NRP-ZKU cable

1 = Signal source

2 = R&S NRP power sensor

3 = Host interface connector

4 = R&S NRP-ZKU cable

5 = USB connector

6 = Computer with installed VISA driver or R&S NRP Toolkit

Incorrectly connecting/disconnecting the R&S NRP power sensors can dam-
age the power sensors or lead to erroneous results.

Ensure that you connect/disconnect your power sensor as described in
Chapter 4, "Preparing for Use", on page 10.

1. Connect the cables as shown in Figure 4-1 :

a) Connect the R&S NRP-ZKU cable to the power sensor.
See "To connect a cable to the host interface of the power sensor"
on page 13.

b) Connect the R&S NRP-ZKU cable to the computer.

c) Connect the power sensor to the signal source.

2. On the computer, start a software application to view the measurement
results.
See Chapter 6, "Operating Concepts", on page 31.

4.6.1.2 R&S NRP-Z5 Sensor Hub Setup

The R&S NRP-Z5 sensor hub (high-speed USB 2.0) can host up to four R&S
NRP power sensors and provides simultaneous external triggering to all connec-
ted sensors.
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R&S®NRP Series Preparing for Use
Connecting to a Controlling Host
Required equipment
® 1 to 4 R&S NRP power sensors
® 1 R&S NRP-ZK6 cable per sensor

® R&S NRP-Z5 sensor hub with external power supply unit and USB cable
® BNC cables to connect the trigger input and trigger output signals (optional)

Setup

?
'@

:!%H DE&SCHWARZ
NRP-Z5 - SENSOR HUB

Figure 4-2: Setup with an R&S NRP-Z5 sensor hub

= R&S NRP-Z5 sensor hub
= External power supply unit (supplied)
= Power cable (supplied)
= AC power supply
= USB cable (supplied)
= Computer with USB host interface
,8 =BNC cable (optional, not supplied)
= Trigger source (optional)
10 = Triggered device (optional)
11-14 = R&S NRP-ZK6 cable

O~NOOAaAPhWwWN =
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Connecting to a Controlling Host

15 = Host interface connector
16 = R&S NRP power sensor
17 = Signal source

Incorrectly connecting/disconnecting the R&S NRP power sensors can dam-
age the power sensors or lead to erroneous results.

Ensure that you connect/disconnect your power sensor as described in
Chapter 4, "Preparing for Use", on page 10.

1. Connect the cables as shown in Figure 4-2:

a) Connect the R&S NRP-ZK6 cable to the power sensor.
See "To connect a cable to the host interface of the power sensor”
on page 13

b) Connect the power sensors to the R&S NRP-Z5 sensor hub. You can con-
nect up to four sensors.

c) Connect the R&S NRP-Z5 to the computer.

d) Connect the power sensors to the signal source.

e) Connect the delivered external power supply unit to the R&S NRP-Z5 and
to an AC supply connector.

f) Connect the trigger input of the R&S NRP-Z5 with a BNC cable to the trig-
ger source (optional).

g) Connect the trigger output of the R&S NRP-Z5 with a BNC cable to the
trigger device (optional).

2. On the computer, start a software application to view the measurement
results.
See Chapter 6, "Operating Concepts", on page 31.

4.6.2 Base Unit

As a controlling host, you can use an R&S NRX or R&S NRP2 base unit. You can
also operate the power sensor using other supported Rohde & Schwarz instru-
ments with a sensor connector. For details, see also the user manual of the
instrument.

» Establish the connection with the base unit using:

e Host interface
See Chapter 6.7, "R&S NRX", on page 43
See Chapter 6.8, "R&S NRP2", on page 44
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Connecting to a Controlling Host

e LAN interface, if:
— Base unitis an R&S NRX
— Power sensor is a LAN power sensor

See Chapter 4.6.3, "Using a LAN Connection", on page 18.

4.6.3 Using a LAN Connection

Requires power sensors with networking capabilities, the R&S NRP LAN
power sensors.

4.6.3.1 Connecting a LAN Power Sensor to the LAN

Depending on the available equipment, you can choose from different ways to
connect a LAN power sensor to a controlling host.

The Ethernet interface of a LAN power sensor requires PoE (power over
Ethernet). See Chapter 5.5, "LAN PoE Interface", on page 29.

Electromagnetic interference (EMI) can affect the measurement results. To
avoid any impact, use category 5 cables or better.

Setup with a PoE Ethernet switch

Figure 4-3: Setup with a PoE Ethernet switch
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Connecting to a Controlling Host

1 = Signal source

2 =LAN power sensor

3 = RJ-45 Ethernet connector

4, 6 = RJ-45 Ethernet cable

5 = Ethernet switch supporting PoE power delivery, e.g. R&S NRP-ZAP1
7 = Controlling host

1. Connect the RF connector of the sensor to the DUT.
See Chapter 4.4, "Connecting to a DUT", on page 12.

2. NOTICE! Risk of sensor damage. Use only PoE power sourcing equipment
(PSE) according to IEEE standards 802.3af or IEEE 802.3at.
Otherwise your power sensor can get damaged.

Connect the RJ-45 Ethernet connector of the sensor to an Ethernet switch
that supports PoE power delivery.

3. Connect the controlling host to the Ethernet switch.

4. Establish a connection between the power sensor and the network.
See Chapter 4.6.3.2, "Establishing a Connection to the Network",
on page 21.

Setup with a PoE injector and a non-PoE Ethernet switch

Figure 4-4: Setup with a PoE injector and a non-PoE Ethernet switch

= Signal source

= LAN power sensor

= RJ-45 Ethernet connector
, 7,9 = RJ-45 Ethernet cable

= PoE injector

A wWwN =
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Connecting to a Controlling Host

= AC supply
= Non-PoE Ethernet switch
= Controlling host

. Connect the RF connector of the sensor to the DUT.

See Chapter 4.4, "Connecting to a DUT", on page 12.

NOTICE! Risk of sensor damage. Use only PoE power sourcing equipment
(PSE) according to IEEE standards 802.3af or IEEE 802.3at.
Otherwise your power sensor can get damaged.

Connect the RJ-45 Ethernet connector of the sensor to the output of the PoE
injector.

Connect the PoE injector to a power supply.
Connect the input of the PoE injector to the non-PoE Ethernet switch.
Connect the controlling host to the non-PoE Ethernet switch.

Establish a connection between the power sensor and the network.
See Chapter 4.6.3.2, "Establishing a Connection to the Network",
on page 21.

Setup with a PoE injector

Figure 4-5: Setup with a PoE injector

1

2
3
4,

= Signal source
= LAN power sensor
= RJ-45 Ethernet connector

7 = RJ-45 Ethernet cable
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Connecting to a Controlling Host

= PoE injector
= AC supply
= Controlling host

. Connect the RF connector of the sensor to the DUT.

See Chapter 4.4, "Connecting to a DUT", on page 12.

NOTICE! Risk of sensor damage. Use only PoE power sourcing equipment
(PSE) according to IEEE standards 802.3af or IEEE 802.3at.
Otherwise your power sensor can get damaged.

Connect the RJ-45 Ethernet connector of the sensor to the output of the PoE
injector.

Connect the PoE injector to a power supply.
Connect the controlling host to the input of the PoE injector.

Establish a network connection between the power sensor and the controlling
host.

4.6.3.2 Establishing a Connection to the Network

There are two methods to establish a network connection:

Power sensor and controlling host are connected to a common network
(infrastructure network).

Power sensor and controlling host are connected only over the switch
(peer-to-peer network).

In both cases, you can address the LAN power sensor as follows:

Chapter 4.6.3.3, "Using Hostnames", on page 22
Chapter 4.6.3.4, "Assigning the IP Address", on page 24

To set up a network Ethernet connection

1.

Connect the power sensor as described in Chapter 4.6.3.1, "Connecting a
LAN Power Sensor to the LAN", on page 18.

By default, the power sensor is configured to use dynamic TCP/IP configura-
tion (DHCP) and to obtain the address information automatically.

If both LAN status LEDs are illuminated in green color, the power sensor is
correctly connected to the network.

Note: Establishing a connection can take up to 2 minutes per device.
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Connecting to a Controlling Host

2. If the LAN status LEDs show another state, no connection is possible. For
possible solutions, see:
e "Network status LED" on page 30
e "Troubleshooting for peer-to-peer connections" on page 22

Troubleshooting for peer-to-peer connections
1. Allow a waiting time, especially if the computer was used in a network before.

2. Check that only the main network adapter is active on the computer. If the
computer has more than one network interfaces, explicitly disable all other
network interfaces if you plan to utilize a peer-to-peer connection to the power
sensor.

3. Check that the remaining main network adapter has been assigned an IP
address starting with 169.254. The IANA (Internet assigned numbers author-
ity) has reserved the range 169.254.0.010169.254.255.255 for the allo-
cation of automatic private IP addresses (APIPA). Addresses from this range
are guaranteed to cause no conflicts with any routable IP address.

4. Try to establish a connection to the power sensor with both the default host-
name and the hostname extended with . 1ocal, for example:
nrpl8sn-101441
nrpl8sn-101441.1ocal

4.6.3.3 Using Hostnames

In a LAN that uses a domain name system (DNS) server, each connected com-
puter or instrument can be accessed via an unambiguous hostname instead of an
IP address. The DNS server translates the hostname to the IP address. Using the
hostname is especially useful when a DHCP server is used, as a new IP address
can be assigned each time the instrument is restarted.

Each power sensor is delivered with a default hostname assigned. You can
change the default hosthame.

Default hostname

The default hosthame follows the syntax:

<device name>-<serial number>, where:

® <device name> is the short name of your sensor.
For example, the <device name> of R&S NRP18SN is nrpl8sn.
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® <serial number> is the individual serial number of the power sensor. The

serial number is printed on the name plate at the rear side of the sensor. Itis
part of the device ID printed above the barcode:

&>1D: 1419.0035K02 {101441} 2d| ol Number

Figure 4-6: Serial number on the name plate

Example:
Serial number of the power sensor: 101441
Default hostname: nrp18sn-101441

Hostname in zero configuration networks, including peer-to-peer networks

The power sensor supports zero configuration networking, used in networks with-
out DHCP server, such as peer-to-peer networks. Thus, you can connect the
power sensor to a network without setting up services such as dynamic host con-
figuration protocol (DHCP) and domain name system (DNS), or configuring the
network settings manually.

For establishing a connection to the power sensor, try the default hostname and
the hostname extended with . 1ocal as shown in the example below. All commu-
nication for resolving names in the top-level-domain (TLD) . 1ocal are defined to
be executed using dedicated local services and ports if no other DNS (domain
name server) is available.

Example:
Default hostname: nrp18sn-101441
Extended hostname: nrpl18sn-101441.1ocal
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4.6.3.4 Assigning the IP Address

Depending on the network capabilities, the TCP/IP address information for the
LAN power sensor can be obtained in different ways:

® |f the network supports dynamic TCP/IP configuration using the dynamic host
configuration protocol (DHCP), the address information can be assigned auto-
matically.

If the network does not support DHCP, the LAN power sensor tries to obtain
the IP address via the zeroconf (APIA) protocol. If this attempt does not suc-
ceed or if the instrument is set to use alternate TCP/IP configuration, the IP
address must be set manually.

For a description on how to set the IP address manually, refer to the user
manual.

O Use hostnames to identify the sensor

In networks using a DHCP server, it is recommended that you address the
sensor by its unambiguous hostnames, see Chapter 4.6.3.3, "Using Host-
names", on page 22.

A hostname is a unique identifier of the power sensor that remains perma-
nent as long as it is not explicitly changed. Hence, you can address a power
sensor by the same identification, irrespectively if a network or a point-to-
point connection is used.
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5 R&S NRP Power Sensors Tour

This chapter provides an overview of the available connectors and LEDs of the
power sensor.

In Figure 5-1, the USB power sensor is shown on the left, the LAN power sensor
is shown on the right.

Figure 5-1: R&S NRP series power sensors (example)

1 = RF connector, see Chapter 5.1, "RF Connector", on page 26

2 =Trigger I/0O connector, see Chapter 5.2, "Trigger I/O Connector", on page 28

3 = Host interface connector, see Chapter 5.3, "Host Interface", on page 28

4 = Status LED, see Chapter 5.4, "Status LED", on page 28

5 = LAN connector, see Chapter 5.5, "LAN PoE Interface", on page 29

6 = LAN reset button, see "LAN reset button" on page 29

7 = Power over Ethernet status LED, see "Power over Ethernet status LED" on page 29
8 = Network status LED, see "Network status LED" on page 30
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5.1 RF Connector

RF Connector

The RF connector is used for connecting the power sensor to a device under test
(DUT) or a signal generator. See Chapter 4.4, "Connecting to a DUT",

on page 12.

For maximum measurement accuracy, tighten the RF connector using a torque
wrench with a nominal torque as specified in the following table.

Table 5-1: R&S NRPxxA(N) RF connector characteristics

Power sensor

Male connector

Matching female

Tightening torque

R&S NRP18AN

connector
R&S NRP6A
R&S NRP6AN
N N 1.36 Nm (12" Ibs)
R&S NRP18A

Table 5-2: R&S NRPxxS(N) RF connector characteristics

Power sensor

Male connector

Matching female

Tightening torque

connector
R&S NRP8S
R&S NRP8SN
N N 1.36 Nm (12" Ibs)
R&S NRP18S
R&S NRP18SN
R&S NRP33S
3.50 mm/ 2.92 mm/
R&S NRP33SN 3.50 mm SUA
R&S NRP33SN-V
R&S NRP40S
2.92 mm 3.50 mrg{wi% mm/
R&S NRP40SN 0.90 Nm (8" Ibs)
R&S NRP50S
2.4 mm 2.4 mm/ 1.85 mm
R&S NRP50SN
R&S NRP67S
1.85 mm 1.85 mm

R&S NRP67SN
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Table 5-3: R&S NRP18S-xx RF connector characteristics

RF Connector

Power sensor

Male connector

Matching female
connector

Tightening torque

R&S NRP18S

N

N

1.36 Nm (12" Ibs)

Table 5-4: R&S NRPxxT(N) RF connector characteristics

Power sensor

Male connector

Matching female

Tightening torque

connector
R&S NRP18T
N N 1.36 Nm (12" Ibs)

R&S NRP18TN
R&S NRP33T

3.50 mm
R&S NRP33TN 3.50 mm/ 2.92 mm/
R&S NRP40T SMA

2.92 mm
R&S NRP40TN
R&S NRP50T

2.4 mm 0.90 Nm (8" Ibs)
R&S NRP50TN

2.4 mm/ 1.85 mm

R&S NRP67T

1.85 mm
R&S NRP67TN
R&S NRPO0OT

1.35 mm 1.35 mm
R&S NRP90TN
R&S NRP110T 1.0 mm 1.0 mm 0.23 Nm (2" Ibs)

Table 5-5: R&S NRPxxTWG RF connector characteristics

Power sensor Male Matching |Frequency range Tightening torque
connec- |female
tor connector
R&S NRP75TWG WR-15 WR-15 50 GHz to 75 GHz
R&S NRPOOTWG WR-12 WR-12 60 GHz to 90 GHz 0.58 Nm (5" Ibs)
R&S NRP110TWG WR-10 WR-10 75 GHz to 110 GHz

* Use the torque wrench of the R&S tool with the part number 1175.2014.02.
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Status LED
5.2 Trigger I/O Connector

The trigger I/O is a connector of SMB type.

It is used as an input for signals if the trigger source parameter is set to
EXTernal?. Itis used as an output for trigger signals if the sensor is operated in
the trigger master mode.

Further information:
® For details on configuration, see the user manual.

5.3 Host Interface

The host interface is used for establishing a connection between the power sen-
sor and a USB host. For this purpose, an external cable is needed. See Chap-
ter 4.5, "Connecting a Cable to the Host Interface", on page 13.

5.4 Status LED

The status LED gives information about the state of the power sensor. The follow-
ing states are defined:

Indication State
O White Idle state. The sensor performs no measurement and is ready
for use.
O Flashing white Firmware update is in progress
@) Slow flashing Sanitizing in progress
white
o Yellow Wait for trigger state
o Green Measuring state
(@) Turquoise blue Zeroing is in progress
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LAN PoE Interface

Indication State

o Slow flashing red | Static error
You can query the error type with SYSTem: SERRor?

o Fast flashing red | Critical static error
You can query the error type with SYSTem: SERRor?

Note: If this state occurs after a firmware update, the update
was not successful. Perform the firmware update again.

5.5 LAN PoE Interface

Available only for LAN power sensors.

An RJ-45 connector is used to connect the Ethernet interface of the power sen-
sors to a local area network (LAN).

Ethernet interface requires PoE (power over Ethernet)

If the Ethernet interface of the LAN power sensors is used, the electrical
power has to be provided by power over Ethernet (PoE). In this case, it is
not possible to provide the power supply via the USB connector instead.

NOTICE

Risk of sensor damage

Use only PoE power sourcing equipment (PSE) according to IEEE stand-
ards 802.3af or IEEE 802.3at.

Otherwise your power sensor can get damaged.

LAN reset button

The LAN reset button is used for resetting the Ethernet connection parameters of
the power sensor to their default values.

Power over Ethernet status LED
Available only for LAN power sensor.

The power status LED shows whether the sensor is correctly powered over PoE
or not.
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LAN PoE Interface

Color State
Green The sensor is powered over PoE. You can operate it using the Ethernet interface.
No light No PoE power is present.

Network status LED
Available only for LAN power sensor.

The network status LED shows whether the LAN connection to the network is
established properly or not.

Color State

Green The power sensor is correctly connected to the network.
It has been assigned a valid IP address, either manually or via DHCP.

Red The power sensor is not connected to the network correctly.

Either the connection is erroneous or the sensor has not been assigned a valid
IP address yet.
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6  Operating Concepts

For operating the power sensor, you can choose from various possibilities:
® Chapter 6.2, "Browser-Based User Interface", on page 34

® Chapter 6.3, "Remote Control", on page 37

® Chapter 6.4, "R&S NRPV", on page 37

® Chapter 6.5, "R&S Power Viewer", on page 40

® Chapter 6.6, "R&S Power Viewer Mobile", on page 42

® Chapter 6.7, "R&S NRX", on page 43

® Chapter 6.8, "R&S NRP2", on page 44

6.1 R&S NRP Toolkit

Before you start using the power sensor, it is recommended to install the
R&S NRP Toolkit.

The R&S NRP Toolkit is the basic software package that supplies low-level driv-
ers and tools for all power sensors. The components of the R&S NRP Toolkit
depend on the operating system.

6.1.1 Versions and Downloads

The R&S NRP Toolkit is available for:

® Microsoft Windows operating systems, as listed in Chapter 6.1.2, "System
Requirements”, on page 32

® Linux distributions
® macOS
Several R&S NRP Toolkit versions are available on your documentation CD-

ROM. The latest version for Windows is available at www.rohde-schwarz.com/
software/nrp-toolkit.
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To obtain an R&S NRP Toolkit for an operating system other than Microsoft Win-
dows, contact the Rohde & Schwarz customer support: customersupport@rohde-
schwarz.com

6.1.2 System Requirements

Hardware requirements:
® Desktop computer or laptop, or an Intel-based Apple Mac
® |AN interface and equipment for setting up a LAN connection.
See Chapter 4.6.3, "Using a LAN Connection", on page 18.
Supported operating systems:
® Microsoft Windows versions
— Microsoft Windows Vista 32/64-bit
— Microsoft Windows 7 32/64-bit
— Microsoft Windows 8/ 8.1 32/64-bit
— Microsoft Windows 10 32/64-bit

® For information on other operating systems, see Chapter 6.1.1, "Versions and
Downloads", on page 31.

6.1.3 R&S NRP Toolkit for Windows

The R&S NRP Toolkit installer for Windows-based systems contains the compo-
nents described in the release notes available at www.rohde-schwarz.com/soft-
ware/nrp-toolkit.

Installing on a computer

1. Start the R&S NRP Toolkit installer on the Windows-based computer.

In the "NRP-Toolkit Setup" dialog, the correct R&S NRP Toolkit version for
your operating system, 32-bit or 64-bit, is already selected.

2. Enable the components you want to install.
e "NRP-Toolkit (SDK)"
The software development kit (SDK) provides programming examples for
the R&S power sensors.
e "IVI Shared Components"
Installs the USBTMC driver. Enabled by default because the installation is
recommended.
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See also Table 7-1.

&7 R&S NRP-Toolkit Setup - %

R&S NRP-Toolkit

Welcome

Setup will install R&5S MRP-Toolkit on your computer. Click install to
continue, options to set the install directory or Close to exit,

MRP-Toolkit (32-bit)

EZIINRP- Toolkit SDK
IVl Shared Components (requires NET Framework v2.0 or higher)

Ré&S5 MRP-Toolkit license terms.

Version 4.16.6809.16836

[l agree to the license terms and conditions

ROHDE&SCHWARZ
I Options | &lnstal Llose

3. Accept the license terms to continue with the installation.

4. Click "Next" and complete the installation process.

6.1.3.1 Components of the R&S NRP Toolkit

Access: "Start" > "NRP-Toolkit"
The following tools are part of the R&S NRP Toolkit for Windows.

Configure Network Sensor
Useful if you have troubles establishing a LAN connection with an R&S NRP LAN
power sensor. The tool provides the following functions:

® Configuring the network settings by (temporary) connecting the selected sen-
sor to the computer using USB.

® Discovering the sensors that have been configured via the Zeroconf (APIA)
protocol.

The tool comes with a guide (PDF) that is also available in the "Start" menu. The
guide explains the network setup.
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Firmware Update

You can use the Firmware Update for NRP Family program to load new firmware
for the power sensors.

For further details, see the user manual.

NRP Version Display

Displays version information of all installed, power measurement-relevant soft-
ware packages.

R&S NRP-Z Uncertainty Calculator

Determines the expanded measurement uncertainty. The tool comes with a man-
ual (PDF) that is also available in the "Start" menu.

S-Parameter Update Multi
Helps loading an S-parameter table into the power sensor.

For further details, see the user manual.

Terminal

Low-level communication program for sending commands to the power sensor.

6.2 Browser-Based User Interface

Requires a power sensor with networking capabilities, a R&S NRP LAN
power sensor.

With the integrated, browser-based graphical user interface of the LAN power
sensor, you can easily configure the most common settings and measure in the
provided measurement modes.

There is no installation required. The web user interface can be used with all devi-
ces and operating systems, including tablets and smart phones that are connec-
ted to the same network.
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Required equipment

® R&S NRP LAN power sensor
® | AN cables
® PoE Ethernet switch or a non-PoE Ethernet switch and a PoE injector
® Device with a supported web browser installed:
— Mozilla Firefox 33 or later
— Google Chrome 36 or later
— Microsoft Internet Explorer 10 or later
— Safari 5.1 or later

Setup

Figure 6-1: Setup with the web user interface

= Signal source

LAN power sensor

RJ-45 Ethernet connector

4, 6 = RJ-45 Ethernet cable

5 = Ethernet switch supporting PoE power delivery

7 = Computer with a supported web browser installed

WN =

Incorrectly connecting/disconnecting the R&S NRP power sensors can dam-
age the power sensors or lead to erroneous results.

Ensure that you connect/disconnect your power sensor as described in
Chapter 4, "Preparing for Use", on page 10.
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Starting a measurement

1. Connect the cables as shown in Figure 6-1.
For a detailed description, refer to Chapter 4.6.3, "Using a LAN Connection",
on page 18.

2. Open a supported web browser.

3. Enter the instrument name or the IP address of the sensor you want to con-
nect to.
Example: http://nrp33sn-123456
For details on how to find out the IP address or hostname, refer to Chap-
ter 4.6.3.4, "Assigning the IP Address", on page 24 and Chapter 4.6.3.3,
"Using Hostnames", on page 22.

NRP185N-900161 System tatus

Measurement Frequency Offset S-Parameter Averaging

. ON | | 50.0| MHz | 0.0| dB | | lauto 0.01 dB VH 0.01 | dB
Continuous Average Aperture Time 20.0| ms
g
@
g Timeslot Smoothing

Trace
Sensor

e Averaging

]

k1l

~ -69.695dBm

The main dialog of the web user interface opens.
4. Select the "Continuous Average" tab and perform any necessary changes.
5. Press "Measurement > ON" to start the measurement.

For a detailed description of the web user interface, refer to the corresponding
chapter in the user manual.
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6.3 Remote Control

You can remote control the R&S NRP series power sensor easily. The change to
remote control occurs "on the fly" and has no influence on the manual operation.
Further information:

® See the user manual for details.

® Chapter 7, "Remote Control Interfaces and Protocols", on page 47

® Chapter 4.6.1, "Computer", on page 14

6.4 R&S NRPV

The R&S NRPV enables you to measure power in all available measurement
modes. Also, you can use up to four power sensors simultaneously.

The R&S NRPV is provided on your documentation CD-ROM and on the Rohde
& Schwarz website as a separate standalone installation package.

Required equipment

® R&S NRP power sensor

® R&S NRP-ZKU cable or an R&S NRP-Z5 sensor hub and an R&S NRP-ZK6
cable to connect the sensor to the computer

® Windows computer with installed:
— R&S NRP Toolkit V 4.20 or higher

— R&S NRPV version 3.2 or higher (refer to the operating manual of the R&S
NRPYV for a description of the installation process)
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Setup

.
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Figure 6-2: Setup with an R&S NRPV

1 = Signal source

2 = R&S NRP power sensor

3 = Host interface connector

4 = R&S NRP-ZKU cable

5 = USB connector

6 = Computer with installed R&S NRPV

Incorrectly connecting/disconnecting the R&S NRP power sensors can dam-
age the power sensors or lead to erroneous results.

Ensure that you connect/disconnect your power sensor as described in
Chapter 4, "Preparing for Use", on page 10.

Starting a measurement

1. Connect the power sensor to the computer as shown in Figure 6-2.
For a detailed description, refer to Chapter 4.6.1.1, "Simple USB Connection",
on page 14.

2. Start the R&S NRPV.

3. Execute zeroing:
Note: Turn off all measurement signals before zeroing. An active measure-
ment signal during zeroing causes an error.

a) Switch off the measurement signal.
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b) Select "Zero > Select > A" (channel short name).
[m Window Help

All Channels Ctrl+Z
Select » A

Zeroing takes several seconds. During zeroing, a message shows the pro-
gress. After completion, the message reports either success or an error
("Success" / "Failed").

4. Switch on the test signal of the signal source.

5. To start a continuous measurement, select "Measure > Continuous".

The "Continuous" measurement window appears. It shows the measurement
results numerically, and the control panel for accessing further dialogs with
parameters for measurement, evaluation and display.

.
& R&S NRPV Virtual Power Meter ol o

File Configure Trigger Measure Zero Window Help

fEREEH MIEEEAN >0 @0 @ &
Contfnuoustnduwl EI@

Configuration

Aav @ Math

Display...

Snapshot

g
R
g :

-47.60dBm

Frequency Standard Deviation Count
1.000 GHz --- 1100
Welcome Taskl.tsk AR R

For a detailed description on how to measure in this setup, refer to the operating
manual of the R&S NRPV.
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6.5 R&S Power Viewer

The R&S Power Viewer is software that simplifies many measurement tasks. It is
provided on your documentation CD-ROM and on the Rohde & Schwarz website
as a separate standalone installation package.

Required equipment

® R&S NRP power sensor

® R&S NRP-ZKU cable or an R&S NRP-Z5 sensor hub and an R&S NRP-ZK6
cable to connect the sensor to the computer

® Computer with installed:
— R&S NRP Toolkit V 4.20 or higher

— R&S Power Viewer version 9.2 or higher (refer to the operating manual of
the R&S Power Viewer for a description of the installation process)

If you want to use an android device like a tablet or a smartphone, use the
R&S Power Viewer Mobile. For details, see Chapter 6.6, "R&S Power
Viewer Mobile", on page 42.

Setup

NRP m
3-Path Diode Power Sensor
~ [ o 23 08m

Figure 6-3: Setup with the R&S Power Viewer

1 = Signal source

2 = R&S NRP power sensor

3 = Host interface connector

4 = R&S NRP-ZKU cable

5 = USB connector

6 = Computer with installed R&S Power Viewer
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Incorrectly connecting/disconnecting the R&S NRP power sensors can dam-
age the power sensors or lead to erroneous results.

Ensure that you connect/disconnect your power sensor as described in
Chapter 4, "Preparing for Use", on page 10.

Starting a measurement

1. Connect the cables as shown in Figure 6-3.
For a detailed description, refer to Chapter 4.6.1.1, "Simple USB Connection",
on page 14.

2. Start the R&S Power Viewer.

3. Execute zeroing:
Note: Turn off all measurement power signals before zeroing. An active mea-
surement signal during zeroing causes an error.

a) Switch off the measurement signal.
b) Select "Sensor > Zero (Signal off) ".

@ R&S5 Power Viewer Plus
File | Sensor] Measurement  Data Processing  Configure  Window  Help

. |z=] Zera (signal off) Cti+Z | —
= { P e

Properties Ctrl+P

F Query Bxtended Information  Ctrl+I

4. Switch on the test signal of the signal source.

5. For a continuous average measurement, select "Measurement" > "Continu-

ous'.

The "Continuous" measurement window appears. It shows the measurement
results numerically and some parameters that can be configured.

6. To start the measurement press "Measurement" > "Start".
The measurement result is shown in the "Continuous" measurement window.
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r
< R&S Power Viewer Plus @M
File Sensor Info Measurement Data Processing  Configure  Window Help
; — = = il ax S
44 - = > BT ) LB
| Continuous RUNNING oo = | CES
f\ Averaging |0 Auto v_|
ll Count | @ 255 v_|

Duty Cyde [ |
I | 10% |

Aperture Time |:|

—38.94 dBm P

Smoothing |:_|

|dBm |v| | Analog | | Statistics | | Relative | | to Ref. |

| NRP 185N, 101438 |v | 5, T Level Offset Signal Frequency

0w 0 0 9 0dB | 1GHz

For a detailed description of how to measure in this setup, refer to the operating
manual of your R&S Power Viewer. The manual is installed automatically during
the installation of the R&S Power Viewer.

6.6 R&S Power Viewer Mobile

The R&S Power Viewer Mobile extends the functionality of the R&S Power
Viewer to Android-based devices, such as a smartphone and tablets.

You can download the R&S Power Viewer Mobile free of charge from the Google
Play Store.

The 1MA215 "Using R&S®NRP Series Power Sensors with Android™ Handheld
Devices" application note gives a detailed description on installation and features
of the R&S Power Viewer Mobile. The application note is provided on the docu-
mentation CD-ROM.
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6.7 R&S NRX

In a measurement, the R&S NRX uses all sensor-dependent measurement func-
tions and displays the results. Thus, you can configure both the measurement
and the power sensor.

Required equipment

® R&S NRP power sensor
® R&S NRP-ZK8 to connect the sensor to the R&S NRX
® R&S NRX

Setup

(2)
G g 12O

@|o ]

Figure 6-4: Setup with an R&S NRX base unit

1 = Signal source

2 = R&S NRP power sensor

3 = Host interface connector

4 = R&S NRP-ZK8

5 = Sensor input connector of the R&S NRX
6 = R&S NRX base unit

Incorrectly connecting/disconnecting the R&S NRP power sensors can dam-
age the power sensors or lead to erroneous results.

Ensure that you connect/disconnect your power sensor as described in
Chapter 4, "Preparing for Use", on page 10.

If the power sensor is a R&S NRP LAN power sensor, you can setup a LAN con-
nection instead of using the sensor input connector of the R&S NRX. See Chap-
ter 4.6.3, "Using a LAN Connection", on page 18.
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Starting a measurement

1. Preset the R&S NRX and the connected R&S power sensors.

a) Press the [Preset] key.
b) Tap "Preset".
All parameters are set to their defaults.

2. Note: Turn off all measurement signals before zeroing. An active measure-
ment signal during zeroing causes an error.
a) Switch off the power of the signal source.
b) Press the [Zero] key of the R&S NRX.
c) Tap "Zero All Sensors".
3. Configure the measurement.

a) In the "Measurement Settings" dialog, select the "Measurement Type", for
example "Continuous Average".
b) Tap "Quick Setup" > "Auto Set".

4. Switch on the signal source.
The measurement starts, and the result is displayed in dBm.

5. If necessary, perform further settings.

For a detailed description of how to measure in this setup, refer to the user man-
ual of the R&S NRX.

6.8 R&S NRP2

With the R&S NRP power sensors and an R&S NRP2, you can measure power
with up to four power sensors simultaneously. All sensor-dependent measure-
ment functions can be used and the results can be displayed in parallel.

Required equipment

® R&S NRP power sensor
® R&S NRP-ZK6 cable to connect the sensor to the R&S NRP2
® R&S NRP2 base unit with FW version 7.11 or higher
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Setup

Figure 6-5: Setup with an R&S NRP2 base unit

1 = Signal source

2 = R&S NRP power sensor

3 = Host interface connector

4 = R&S NRP-ZK6 cable

5 = Sensor input connector of the R&S NRP2
6 = R&S NRP2 base unit

Incorrectly connecting/disconnecting the R&S NRP power sensors can dam-
age the power sensors or lead to erroneous results.

Ensure that you connect/disconnect your power sensor as described in
Chapter 4, "Preparing for Use", on page 10.

Starting a measurement

1. Connect the cables as shown in Figure 6-5:

a) Connect the R&S NRP-ZKG6 cable to the host interface connector of the
sensor.

b) Connect the R&S NRP-ZK6 cable to a sensor input connector of the R&S
NRP2.

c) Connect the [RF] connector of the power sensor to the signal source.

2. Preset the R&S NRP2.

a) Press the [(PRE)SET] hardkey.
The "File" menu appears.

b) Press the [[PRE)SET] hardkey again or press the "Preset" softkey.
All parameters are set to their defaults, even when in inactive operating
modes.

3. Execute zeroing:
Note: Turn off all measurement signals before zeroing. An active measure-
ment signal during zeroing causes an error.
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a) Switch off the power of the signal source.
b) Press the [ZERO] hardkey of the R&S NRP2.
The "Zero" dialog box is displayed.

Zero
Zero (Al {
Zero A |
Zero B {
Zero c |
Zero D

c) Press the [ZERO] hardkey again to perform zeroing of all connected sen-
sor channels ("Zero (All)") or press the appropriate softkey to select a spe-
cific sensor for zeroing.

4. Press the [FREQ] hardkey and enter the carrier frequency of the applied sig-
nal if the specified measurement accuracy is to be reached.

5. Switch on the signal source.
The result window indicates the result (in dBm) obtained with sensor A.

Sensor Windows Measurement File System

1.000 GHz

4036n

6. If necessary, perform further settings.

For a detailed description of how to measure in this setup, refer to the operating
manual of your R&S NRP2.
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7 Remote Control Interfaces and Proto-
cols

For remote control, communication between the R&S NRP series power sensor
power sensors and the controlling host is established based on various interfaces
and protocols.

Depending on the sensor type, the power sensors support different interfaces for
remote control.

® R&S NRP USB power sensors are always accessed using USB.
® R&S NRP LAN power sensors can be accessed using USB or Ethernet.
Table 7-1 describes the protocols that are supported for each interface.

Table 7-1: Remote control interfaces and protocols

Interface Supported | Protocols, VISA") address string and Library

by
USB All e USBTMC
power USB: :<vendor ID>::<product ID>::
Sensors <serial number>[::INSTR]
VISA
®* NRP legacy protocol
Ethernet R&S NRP o VXI-11
LAN power TCPIP::host address[::LAN device name] [::
Sensors INSTR]
VISA

® HiSLIP High-Speed LAN Instrument Protocol (IVI-6.1)
TCPIP::host address::hislipO[::INSTR]
VISA

® Socket communication (LAN Ethernet)
TCPIP::host address[::LAN device name]::
<port>::SOCKET

() VISA is a standardized software interface library providing input and output functions to
communicate with instruments. A VISA installation on the controller is a prerequisite for remote
control over USBTMC and LAN (when using VXI-11 or HiSLIP protocol) interfaces.
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USB Interface
7.1 USB Interface

For remote control using USB connection, the computer and the power sensors
must be connected via the USB interface. A USB connection requires the VISA
library to be installed. VISA detects and configures the R&S power sensors auto-
matically when the USB connection is established. Apart from the USBTMC driver
(which comes with the installation of the R&S NRP Toolkit), you do not have to
install a separate driver.

USB Test & Measurement Class Specification (USBTMC) is a protocol that is built
on top of USB for communication with USB devices. It defines class code infor-
mation of the sensor, that identifies its functionality to load the respective device
driver. Using VISA library, it supports service request, triggers and other opera-
tions that are commonly found in GPIB devices.

Besides USBTMC, the NRP legacy protocol is available to ensure the compatibil-
ity of the R&S NRP power sensors with the R&S NRP-Z series of power sensors.
The usage of this protocol is not recommended for new applications.

The resource string represents an addressing scheme that is used to establish a
communication session with the sensor. It is based on the sensor address and
some instrument- and vendor-specific information.

USB Resource String

The syntax of the used USB resource string is:

USB: :<vendor ID>::<product ID>::<serial number>[::INSTR]
where:

® <vendor ID> is the vendor ID for Rohde & Schwarz (OxOAAD)
® <product ID> is the product ID for the Rohde & Schwarz sensor
® <serial number> is the individual serial number on the rear of the sensor

Table 7-2: R&S NRPxxA(N) USB product IDs

R&S NRP power sensor USB product ID
R&S NRP6A 0x0178
R&S NRP6AN 0x0179
R&S NRP18A 0x014E
R&S NRP18AN 0x014F

Getting Started 1419.0170.02 — 13




R&S®NRP Series Remote Control Interfaces and Protocols

USB Interface

Table 7-3: R&S NRPxxS(N) USB product IDs

R&S NRP power sensor

USB product ID

R&S NRP8S O0x00E2
R&S NRP8SN 0x0137
R&S NRP18S 0x0138
R&S NRP18SN 0x0139
R&S NRP33S 0x0145
R&S NRP33SN 0x0146
R&S NRP33SN-V 0x0168
R&S NRP40S 0x015F
R&S NRP40SN 0x0160
R&S NRP50S 0x0161
R&S NRP50SN 0x0162
R&S NRP67S 0x024A
R&S NRP67SN 0x024B

Table 7-4: R&S NRP18S-xx USB product IDs

R&S NRP power sensor

USB product ID

R&S NRP18S-10

0x0148

R&S NRP18S-20

0x014A

R&S NRP18S-25

0x014C

Table 7-5: R&S NRPxxT(N) USB product IDs

R&S NRP power sensor

USB product ID

R&S NRP18T 0x0150
R&S NRP18TN 0x0151
R&S NRP33T 0x0152
R&S NRP33TN 0x0153
R&S NRP40T 0x0154
R&S NRP40TN 0x0155
R&S NRP50T 0x0156
R&S NRP50TN 0x0157
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R&S NRP power sensor USB product ID
R&S NRP67T 0x0158
R&S NRP67TN 0x0159
R&S NRPOOT 0x026C
R&S NRP90OTN 0x026D
R&S NRP110T 0x015A

Table 7-6: R&S NRPxxTWG USB product IDs

R&S NRP power sensor USB product ID
R&S NRP75TWG 0x01D1

R&S NRPOOTWG 0x01D2

R&S NRP110TWG 0x01D3
Example:

USB::0x0AAD::0x00E2::100001

0x0AAD is the vendor ID for Rohde & Schwarz.

0x00EZ2 is the product ID for the R&S NRP8S power sensor.
100001 is the serial number of the particular power sensor.

7.2 Ethernet Interface

The Ethernet interface of the R&S NRP LAN power sensors allows you to inte-
grate them in a local area network (LAN).

For remote control via a network, the computer and the power sensor must be
connected via the Ethernet interface to a common network with TCP/IP network
protocol. The TCP/IP network protocol and the associated network services are
preconfigured on the power sensor. Software for device control and the VISA pro-
gram library must be installed on the computer.

7.21 VISA Resource Strings

The VISA resource string is required to establish a communication session
between the controller and the power sensor in a LAN. The resource string is a
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unique identifier, composed of the specific IP address of the sensor and some
network and VISA-specific keywords.

TCPIP::<IP address or hostname>[::<LAN device name>][::INSTR]

® TCPIP designates the network protocol used

® <P address or hostname> is the IP address or host name of the device

® [:<LAN device name>] defines the protocol and the instance number of a sub-
instrument:

e [::INSTR]indicates the power sensors resource class (optional)
The IP address or hostname is used by the programs to identify and control the
sensor. While the hostname is determined by settings in the sensor, the IP

address is assigned by a DHCP server when the sensor requests one. Alterna-
tively the IP address is determined with a procedure called Zeroconf.

You can also assign a LAN device name which defines the protocol characteris-
tics of the connection. See the description of the VISA resource string below for
the corresponding interface protocols. The string of the LAN device name is
emphasized in italics.

HiSLIP

TCPIP::<IP address or hostname>::hislipO[::INSTR]

® hislip0 is the HiSLIP device name, designates that the interface protocol
HiSLIP is used (mandatory)

hislip0 is composed of [::HiSLIP device name[,HiSLIP port]] and must be
assigned.

For details of the HiSLIP protocol, refer to Chapter 7.2.3, "HiSLIP Protocol",
on page 52 .
VXI-11

TCPIP::<IP address or hostname>[::instO][::INSTR]

® jnstOis the LAN device name, indicating that the VXI-11 protocol is used
(optional)

inst0 currently selects the VXI-11 protocol by default and can be omitted.

For details of the VXI-11 protocol, refer to Chapter 7.2.2, "VXI-11 Protocol",
on page 52 .
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Socket Communication

TCPIP::<IP address or hostname>::port::SOCKET

® port determines the used port number

® SOCKET indicates the raw network socket resource class

Socket communication requires the specification of the port (commonly referred

to as port number) and of "SOCKET" to complete the VISA resource string with
the associated protocol used.

The default port for socket communication is port 5025.

For details of the socket communication, refer to Chapter 7.2.4, "Socket Commu-
nication”, on page 53.

Example:

A power sensor has the |IP address 10.7711.11.20; the valid resource string using
VXI-11 protocol is:

TCPIP::10.111.11.20::INSTR

The DNS host name is nrp18sn-100001; the valid resource string is:
TCPIP::nrp18sn-100001::hislip0 (HiSLIP)
TCPIP::nrp18sn-100001::inst0 (VXI-11)

A raw socket connection can be established using:
TCPIP::10.111.11.20::5025::SOCKET
TCPIP::nrp18sn-100001::5025::SOCKET

7.2.2 VXI-11 Protocol

The VXI-11 standard is based on the ONC RPC (Open Network Computing
Remote Procedure Call) protocol which in turn relies on TCP/IP as the network/
transport layer. The TCP/IP network protocol and the associated network services
are preconfigured. TCP/IP ensures connection-oriented communication, where
the order of the exchanged messages is adhered to and interrupted links are
identified. With this protocol, messages cannot be lost.

7.2.3 HIiSLIP Protocol

The HiSLIP (high-speed LAN instrument protocol) is the successor protocol for
VXI-11 for TCP-based instruments specified by the IVI foundation. The protocol
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uses two TCP sockets for a single connection - the first for fast data transfer, the
second one for non-sequential control commands (e.g. Device Clear or SRQ).

HiSLIP has the following characteristics:

® High performance as with raw socket network connections

® Compatible IEEE 488.2 support for Message Exchange Protocol, Device
Clear, Serial Poll, Remote/Local, Trigger, and Service Request

® Uses a single IANA registered port (4880), which simplifies the configuration
of firewalls

® Supports simultaneous access of multiple users by providing versatile locking
mechanisms

e Usable for IPv6 or IPv4 networks

The HiSLIP data is sent to the device using the "fire and forget" method with
immediate return. Opposed to VXI-11, where each operation is blocked until
a VXI-11 device handshake returns. Thus, a successful return of a VISA
operation such as viWrite () does not guarantee that the sensor has fin-
ished (or even started) executing the requested command. It just indicates
that the command has been delivered to the TCP/IP buffers.

For more information see also the application note at:

http://www.rohde-schwarz.com/appnote/1MA208.

7.24 Socket Communication

An alternative way for remote control of the software is to establish a simple
TCP/IP connection to the device using the standard network drivers of your oper-
ating system. The so-called "socket" on Linux, "winsock" on Windows. The socket
communication, also referred to as "raw Ethernet communication", does not nec-
essarily require a VISA installation on the remote controller side.

Socket connections are established on a specially defined port. The socket
address is a combination of the IP address or hostname of the sensor and the
number of the port configured for remote control. The power sensors use port
number 5025 for this purpose.
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8  Contacting Customer Support

Technical support — where and when you need it

For quick, expert help with any Rohde & Schwarz product, contact our customer
support center. A team of highly qualified engineers provides support and works

with you to find a solution to your query on any aspect of the operation, program-
ming or applications of Rohde & Schwarz products.

Contact information

Contact our customer support center at www.rohde-schwarz.com/support, or fol-
low this QR code:

r

Figure 8-1: QR code to the Rohde & Schwarz support page
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